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The Chairperson welcomed Terri Clark, Data Center Manager, Computer Services,
Legislative Administrative Services (LAS), who reviewed the conversion from GroupWise to Microsoft
Exchange (Attachment 1). She said that the migration to Microsoft Outlook meets Chief Information
Technology Architect and Information Technology Executive Council standards, as well as being
integrated with the Kansas Legislative Information System Strategic Plan (KLISS) architecture; the
project cost will be completed 4.34 percent ($12,198) under budget. She provided a migration
schedule (estimated to be completed 11 days over schedule) (Attachment 2) and noted the
availability of web access training (Attachment 3). Ms. Clark replled to a question that GroupWise
servers will be discontinued after June 30, 2009.

David Larson, Director, Computer Services, LAS, commented on the cost of the KLISS

Project, saying that the project costs have been reduced by 49 percent through license savings and
" using staff, rather than consultants, for project work (Attachment 4). Commenting on the expiring
Dell laptop lease for legislators, Mr. Larson said the old laptops should be turned in by May 30 and
the new Dell laptops will be distributed later in June.

Carmen Alldritt, Director, Division of Motor Vehicles, Kansas Department of Revenue,
reporting on the Photo First Model Office Project, said that the project received Kansas Information
Technology Office (KITO) approval January 9, 2009, that a federal grant was provided ($925,000),
that final approval for the system was received April 30, 2009, and that the system will be ready for
pilot testing by September 2009 (Attachment 5).

Anthony Schlinsog, Chief, Bureau of Computer Services, Kansas Department of
Transportation (KDOT), briefed the Committee on two projects: the Comprehensive Program
Management System Replacement (sub-project 4), and the interface with the Financial Management
System (now called SMART-Statewide Management Accounting and Reporting Tool). He stated
that the former is nearing completion and scheduled to go live over Labor Day 2009. Regarding the
latter, he commented that two systems will be replaced by SMART: the Voucher Entry System and
the Integrated Financial Management System. He noted that several other systems will need
interfaces in order to function with SMART, interfaces that will be incrementally implemented with
the possibility of later being merged with SMART. The estimated cost is $779,707, with a close-out
date of December 2011 (Attachment 8). The Chairperson stated that SMART was intended to
supplant agency financial management systems; he expressed concern that KDOT deemed some
function conversions optional and requested further information to determine why some application
conversions are considered optional. Responding to a question, Mr. Schlinsog said that KDOT rarely
interacts with the Kansas Turnpike Authority on projects.

Keith Meyers, Director of Training Services, Kansas Department of Commerce, reviewed the
Regional Education and Workforce Access Remote Delivery (REWARD) project, which proposes
deploying high-definition videoconferencing- units-to-libraries-and community/technical colleges
throughout the state (Attachment 7). Explaining that this technology-based method of providing
employment and training services will obviate the need for bricks-and-mortar locations and will save

staff time, he commented that the project relies entirely on federal funds, but was placed on hold
pending JCIT review.

Don Jordan, Secretary, Kansas Department of Social and Rehabilitation Services (SRS),
presented two new projects to the Committee (Attachment 8). He said that the Protection Reporting
Center will standardize and automate the reporting of suspected adult and child abuse/neglect and
will interface with the Family and Child Tracking System (FACTS). After receiving KITO approval,
SRS contracted with Harmony Consultants for $738,908 to implement the system by February 11,
2010. He explained that much of the cost for the project has been encumbered, since the project
has been accumulating funds since FY 2007. Answering a question, Mr. Jordan replied that the up-



-3-

front funds for the project are all State General Fund, but federal matching funds will be available
after the project is implemented. He replied that the project will replace manual processes and is

critical enough that the agency plans to proceed, especially since most of the funds ($788,908) are
currently encumbered and available.

Reporting on HATS (Host Access Transformation Services), Mr. Jordan said the
infrastructure project is a temporary patch to keep an antiquated system running until funds are
available to continue the $45 million Human Services Management System. Responding to a

question, Jeff Lewis, Chief Information Officer, SRS, said HATS is a life-support interface done by
SRS staff.

Steve Montgomery, Chief Information Officer, Kansas Bureau of Investigation (KBI), informed
the JCIT that the planned Central Message Switch (CMS) replacement, a core communication
component for KCJIS (Kansas Criminal Justice Information System) hardware, must be delayed and
the funds diverted to upgrade the frame-relay system which provides dedicated connectivity to each
of the state’s 105 counties (Attachment 9). Mr. Montgomery requested that the JCIT recommend
retaining the $605,200 for the message switch replacement and recommend a budget enhancement
to fund the KCJIS circuit upgrades. Answering questions, Mr. Montgomery said the CMS funds are
savings which, if expended elsewhere, cannot be replaced. He replied that the circuit upgrades will
cost an additional $200,000 to $400,000. Don Heiman replied to another question that KAN-Ed uses
the new circuit technology, which, like the KBI, is purchased from an AT&T contract through the
Division of Information Systems and Communications (DISC). Members expressed surprise at the

$416,000 telecommunication costs. The Chairperson requested that Mr. Heiman obtain cost
information from DISC.

Dorothy Stites, Deputy Secretary, Kansas Department of Labor, updated the Committee
regarding the Unemployment Insurance Modernization Project (Attachment 10). She thenintroduced
George Hubka, Chief Information Officer, Kansas Department of Labor, who said that the design
phase had been completed and the project was beginning the build phase; however, issues with
vendor IBM caused the project to be placed on hold. The IBM contract was canceled and the
agency, using the design information, began an incremental approach using agency staff.
Answering questions, Mr. Hubka said the major technology was already in place. He replied that the
online application for unemployment worked well unless special circumstances needed to be
addressed, such as prior military service; if so, then the applicant must use the call center. A
member observed that when the contract with IBM was closed, the project should have been recast
rather than put on hold. To another question, Mr. Hubka said the federal stimulus package required
two changes in the project configuration. ‘

The meeting was adjourned. No further meeting was scheduled. -
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Legislative Microsoft Email and
GroupWare Conversion

— _

Presentation to the J oint Committee on
Information Technology

April 29, 2009
Terri Clark
Data Center Manager

Exchange Server 2007 /Qutlook Features

>»Enterprise email meets CITA/ITEC Standards
»GroupWise twilighted in Technical Architecture v. 12

»Improved spam control with IronPort device
>88.6% incoming mail blocked, only 11.4% valid

»Integrates with KLISS automatic event notification
architecture, including RSS feeds

>Integrates with 3™ party systems - Google Mail,
mobile devices

> Access remotely with https:/ secure web connection
>Available for personal laptops - Microsoft At Home

»Instant Messaging will be OpenFire/Spark — open
source, KLISS integration

Mo&»«f A
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[ Project Status - Budget and Costs J

Project Actual Est. Costto | Estimated
Budget Current Complete Total Cost
Internal $70,382 $20,060 $50,322 $70,382
Expenses
External $210,950 $156,412 $42,340 $198,752
Costs
Total $281,332 $176,472 $92,662 $269,134

Project is Estimated to Complete at
$12,198 (4.34%) Under Budget

Migration Schedule

AN

« Legislative Post Audit

May15® | o ]egislative Administrative Services

« Legislators
« Legislative Staff

May 29th

« Revisor’s Office
« Legislative Research Department

June 20




Project Status - Schedule

J
Plan — Actual - Plan — Date | Actual —
Users Users Date
Pilot Project |30 71 4/20/09 4/20/09
Final 470 429 6/9/09 6/20/09
Migration
500 Users 500 Users 241 Days 252 Days

Project is Estimated to Complete at
11 Days (4.56%) Over Schedule

—
Outlook Training
- N/ N
Scheduled Training One on One Online
« 30 min sessions on the » Convenient — Scheduled « Printed Manual
hour during Veto On Demand with Toni « Online Access
Session + One on One or Small » Phone Support
« Call or Drop In Group

\< AN

N >

.
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Thank you. Questions?

Contact Computer Services:
368-7157
Suite 057-W in the Capitol




The legislature will be migrating from GroupWise email to the legislative Exchange Server 2007 system
following the veto session. Outlook 2007 will be the email client on legislative computers.

The anticipated migration schedule follows:

Representatives:

Last Name begins A-D Second evening following completion of veto session
Last Name begins E—-H . Third evening following completion of veto session
Last Name begins | - M Fourth evening following completion of veto session
Last Name begins N-R Fifth evening following completion of veto session
Last Name begins S-Z Sixth evening following completion of veto session
Senators:

Last name begins A-L Seventh evening following completion of veto session
Last name begins M - Z Eighth evening following completion of veto session

Legislative staff will migrate with their legislator.

When the veto session is complete the migration with actual dates will be published. Migrations will start
at 6:00 pm. The completed email migration will be verified and tested by Computer Services technical
staff. Following the migration we'll be available to answer questions and provide training on Outlook.
Training materials are also available online at https://1a003.state.ks.us/help/index.html

IF YOU HAVE BEEN ARCHIVING EMAIL IN THE GROUPWISE SYSTEM, PLEASE LET US KNOW
BEFORE YOUR SCHEDULED MIGRATION. Your archived mail will be migrated, we just need to know
the location of your archive in advance.

If you use a mobile device we will be happy to synchronize it with the new email system. If you use an
iPhone, Treo, or other device, please be sure the cables are available so we can perform the
synchronization. Please schedule this for the next time you are in the Capitol, or we can provide phone
support for this service. .

To access email during the interim please use Outlook web access.

https://legemail.ks.gov

(Note this is a secure site — https://)

Username = Ig\username

Password = your network password

(If you've created a different GroupWise password it will not work. Please use your network login
password)

For assistance please call the Help Desk at 368-7157 during business hours.

| appreciate your cooperation as we implement the new email system.

Thanks,
Terri
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Microsoft® Office
Outlook® Web Access
2007 Training
Get up to speed

Uses:

» The web interface of Outlook Web Access resembles the
interface in Microsoft Outlook.

» OWA is used to access e-mail, calendars, contacts, tasks,
and other mailbox content from any computer with an
internet connection.

» Microsoft provides Outlook Web Access as part of
Exchange Server to allow users to connect remotely via a
web browser.

« OWA can be used from Internet cafes and any other
location that provides connectivity to the Web.

Outlook Web Access 2007

ST 31
TUT  Y-29-29



The OWA Logon Page

Outlook Web Access
(OWA) allows users to
access their email from
any web browser.

The URL is:
hitps://legemail.ks.gov

What is the difference?
*Public or Shared is configured for shorter connections
Private is configured longer session inactivity timeouts

Rule of thumb: choose Public, unless you are certain
the computer you are working from is safe.

Outlook Web Access 2007

The OWA Logon Page

Enter
Domain\your_user_name
(ex. Lg\leg_last_name)
and

Enter password

Pheiaginwne:

remesme

Both your user name and
password were provided
by Computer Services.

Option:

*Only select “Use Outlook Web Access Light” for slow or
dial-up connections.

*Another screen may appear asking you about your
location and time zone that you may change if needed.
Clicking Next takes you to the Outlook Web Client.

Outlook Web Access 2007

4/2¢
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The Main Screen

Messages

Folder List

s Reading Panel
Navigation Pane :

iy R

Sections:
*Folder List — where you have your inbox and other folders.

*Navigation Pane-where you can select to see your Inbox, Calendar, etc.

Outlook Web Access 2007

The Main Screen

Folder List Messages

Reading Panel

Navigation Pane

] wants soescer, AINGA, 2LU8 151 FM
Fo: Terr Qlerk
Subject: araamer

Ty NBRPRGES 34 0! 697 OGR!

To change the Reading Panel:

«Click on the button on the tool bar and select RIGHT,
BOTTOM or OFF.

Outlook Web Access 2007

. .2009



Introducing the Ribbon

Here's a new e-mail
message. The Ribbon
is at the top of the
window.

The Ribbon is visible
each time you create
or edit something in
Outlook.

Why the new system? Microsoft carefully researched
how people use commands in Outlook.

As a result of that research, some Outlook commands
are now more prominent, and common commands are
displayed and grouped in ways that make them easy to
find and use.

Outlook Web Access 2007

A closer look at the Ribbon

G Rktied  Message (ML)
- Options - FormatTeit .

=Callr (Body} -+ i1

Attach
File®
i

To better help you
learn how to use the
Ribbon, here’s a guide
to its basic
arrangement.

{1} Tabs: The Ribbon is made up of different tabs, each
related to specific kinds of work you do in Outlook.

(2) Groups: Each tab has several groups that show related

items together.

(3 Commands: A command is a button, a box to enter
information, or a menu.

Qutlook Web Access 2007

4/2¢
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The Ribbon shows what you need

Once again, you'll
encounter the Ribbon
when you take certain
actions such as
creating messages,
calendar entries, or
contacts.

The Ribbon shows tabs and commands appropriate for
what you're doing.

That is, the tabs on the Ribbon will differ depending on
the area of Outlook you're working in.

Outlook Web Access 2007

The Ribbon shows what you need

The picture shows
some of these
differences.

{1} A new message shows the Message and Options tabs.
2} A new appointment shows the Appointment tab.

{3 A new contact shows the Contact tab.

Outlook Web Access 2007

.2009



There’s more than meets the eye

A small arrow at the
bottom of a group
means there’s more
available than what
you see.

This button [ is called
the Dialog Box
Launcher.

The picture shows that to see a full list of font options,

you'd click the arrow next to the Basic Text group on the
Message tab of a new e-mail message.

Outlook Web Access 2007

The Mini toolbar

:;’s;

Hach Bl
cayl

Bis tund (pia®contosa,com}

17

. ‘iTraInlng Course

trecoramend the p oSy

The Mini toolbar
allows you to quickly
access formatting
commands right
where you need them:
in the body of an
e-mail message.

The picture shows how it works:

> Select your text by dragging with your mouse, and then

point at the selection.

{2} The Mini toolbar appears in a faded fashion. If you point
to it, it becomes solid. You can click a formatting option.

Outlook Web Access 2007

4/2¢
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The Quick Access Toolbar

The Quick Access
Toolbar is a small
toolbar above the
Ribbon.

I's there to make the
commands you need
and use most often
readily available.

What'’s best about the Quick Access Toolbar? What's on
it is up to you.

That is, you can add your favorite commands to it with a
simple right-click.

Outlook Web Access 2007

Create a new message

It's time to write and
send your first e-mail
e message using the
new Outlook.

What do you need to
know? For starters,
some things haven’t
changed.

The first thing you need to know to get started is that you
don’'t need to know anything new. All of the old ways to
start a new message still work.

In a new message, first get oriented to the Ribbon. The
Message tab is on top, with the commands you're most
likely to use every time you create and send a message.

Outlook Web Access 2007

i
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Create a new message

Using other tabs

If you're having
trouble finding a
command or button,
you may need to look
on another tab.

For example, to insert a picture so that it appears in line
with the text of your message (not as a separate
attachment), you'll need to switch to the Insert tab.

Outlook Web Access 2007

Use the Address Book to add recipients

Uintiled Message TR

Do you use the
Address Book to add
names to the To, Cc,
and Bcc fields?

You'll find the Address Book command on the
Message tab.

Qutlook Web Access 2007

4/2«  J9



Show or hide the Bcc field

If you prefer to type
e-mail addresses
directly in the To and
Cc boxes, you may
also want to know how
you can show the Bee
field so that you can
type names there, too.

The picture shows the location of the Show Bcc
command.

As you can see, you'll find it on the Options tab.

Outlook Web Access 2007

Include your signature

Do you use a personal
e-mail signature at the
end of your Outlook
messages?

If you didn’t use signatures (maybe they seemed too
complex or you could never remember how to create
them or where to find them), you'll be surprised to see
how easy signatures are in Outlook 2007.

Qutlook Web Access 2007

/2009



Include your signature

You can modify
existing signatures or
create new ones, as
well as set a default
signature.

Start by clicking the
arrow under the
Signature command.

The picture shows what happens next:

@ If you created signatures previously, you'll see them
listed here.

(@ To create new signatures, set a default signature, or
modify existing signatures, click Signatures.

Outlook Web Access 2007

Respond to a message

E-mail isn't just about
sending...

...it's also about
receiving and replying.

ovets Create. Othdr i Bladk:
fder . Rule' Actidng > Sendar

When you reply from an open message, you'll use the \
buttons in the Respond group on the Message tab of

the Ribbon.

You'll notice that what's on the Ribbon in a received
message is different from what'’s on it for a new mait
message.

Outlook Web Access 2007

4/2¢ U9
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Include an attachment

Including an attached
document or picture
with your message is
easier than ever.

Just as you've always done, you'll begin by creating a
new message. Then you'll use the Attach File
command on the Ribbon.

Outlook Web Access 2007

Include an attachment

Where you’ll find
Attach File

Including an
attachment is a
common activity, so
you'll find Attach File
on both the Message

tab and the Insert tab.

The picture shows it on the Insert tab.

Outlook Web Access 2007

2009
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Include an attachment

(2 8
Attath | Attach. Busingss' Caténdar Sigiatar

FII;% ftém < Taid ¥

You can’t attach just
anything

Qutlook will block

certain types of file

attachments.

This behavior is unchanged from earlier versions.

However, you may be interested to know that some file
types that were previously blocked are now allowed and

some new types have been added to the blocked list.

Outlook Web Access 2007

Include a picture in line with te

xt

In Outlook, it's easy to
send pictures in the
body of your e-mail
messages instead of

as separately attached

files.

Happy Spring!

To do this:

(1) Click the Picture command on the Insert tab.

(2> As shown in the illustration, you'll see a picture in
body of the message.

the

Qutlook Web Access 2007

4/2¢

J9
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Thank you
any questions in the future
contact Computer Services
368-7157

Outlook Web Access 2007

2009
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Analysis of Project Costs - Active Directory, Network Stabilization, Email Conversion Projecis

P

‘\"1 in Project May 2008 Est Notes Item in Project Nov 2008 Notes
RTG-Choice Proposal $1,600,000 Netwk stabilization $411,000 bids
Deduct project mgt fees $271,000 task perform by T Clark  Email conversion $210,000 bids
Proj Balance $1,329,000
Retail rates inflation $650,000 49% Actual Project bids $621,000
Deduct MS license savings $160,000 commit to MS platiorm  MS license savings $160,000 commit to MS platform
Proj Balance $490,000 Proj Balance $461,000

$130,000 2 yrs savings

$125,000 existing money

$125,000 existing money
~$235,000] 06,0007

206,000}

Db doedt ¢

Jci7

#2907




8 Mark Parkinson, Governor

KA S AS - Joan Wagnon, Secretary
DEPARTMENT OF REVENUE www.ksrevenue.org
To: Joint Committee on Information Technology

From: Carmen Alldritt Director of Vehicles
Department of Revenue

Date:  April 29, 2009

Subject: Photo First Model Office

e Federal Grant received from DHS/FEMA in the amount of $925,000

e Project received KITO approval January 9, 2009

e Review of Functional, Interface, Platform, Document Authentication,
Capture S/W and Server S/W specs

e Final apprbv.al of system development April 30, 2009

e L-1 customize software to KDOR épecifications

e Integration and testing begin July 2009

e UAT and Pilot test September 2009

' DIVISION OF VEHICLES :
DOCKING STATE OFEICE BUILDING, 915 SW HARRISON ST., TOPEKA, KS 66612-1588 P
Voice 785-296-3601 Fax 785-291-3755 hitp://www ksrevenue.org/ ﬂ'ﬁtAM b)

TeiT y-39-07



TESTIMONY BEFORE THE JOINT COMMITTEE ON INFORMATION —
| TECHNOLOGY

REGARDING KDOT _INFORMATION TECHNo_LOGY PROJECTS
. Apr1l 29, 2009
> | M. Cha1rrnan and Commrttee Members
‘Good afternoon My name is Anthony Schlrnsog and I am the Chlef Informatlon Officer for the' : . b, ,
-Kansas Department of Transportation (KDOT). Today I will be providing updates on’ th_e_'_:- e
’ follow1ng 1nformat10n technology (IT) prOJeCts R L SR S ARTIE AR

: . Comprehenswe Program Management System Replacement SubprOJ ect IV
F1nanc1al Management System Integranon (w/ SMART). PI'OJ ect .

Comprehenswe Program Management System Replacement Subprol ect IV

o ,"The current Comprehenswe Program Management System (CPMS) is a:m1ssron-criticalsystem B

" used by the Kansas Department of Transportation (KDOT) to manage the work required to .

Lo support the state’s transportation network. KDOT uses CPMS to provide program, proJect

production, analysis, reporting, and fund management for the Agency’s transportation programs. -

" .-.and for maintenance of the transportation network. The new WinCPMS appl1cat1on will replace

- '_ . The fea51b1l1ty study for the WmCPMS pI'O_] ject began in FY 2004 w1th the Proj ect be1ng recast 1n_'".
“_ October 2007 to better align the project management approach with an agile development ’—

o deployment

s .. as follows

~ the complex legacy mamframe apphcatron and aglng technology that has been in PIOductmn-;' Pl
s1nce1992 IR . o : _ ‘ _

- methodology.” The recast of the project did not extend the original end date of the project and-;l
. slightly decreased the budget. The project is broken into 5 separate subprojects, the first 4 each 5
. adding add1t10nal functlonahty to the system and the last subprOJect Subpro;ect V focused on}.j

_ '__The part1cular subprOJect in quest1on here SubprOJect IV began in January 2009 and is L
- scheduled for completlon prlor to the next ﬁscal year Source of the fundmg for SubprOJ ect IV is o

.-I $1,502939 FY 2007 Encumbered Funds
'S 265,069 FY 2009 Funds

s ‘After the recast, the total pI'O]eCt cost decreased by $576 708 for a total of $8 7l m1ll1on W1th the | =
followmg breakdown DR S iy s T

$O 24M Feas1b1l1ty Study Report (F Y 04- 06)
$6 88M EDS contract (FY 07) :




s 30. 63M Computer hardware, software, trammg, travel (FY 07 09)
e $0.96M Intemal labor cost (FY 07- 10)

~The proj ected completlon date for the WmCPMS pI‘O_] ect remains September 2009 with a go—hve

over Labor Day weekend

Fmanc1al Management System Integratlon (W/SMART) Pro; ect

Earher this month, the State Department of Administration published the 1nterface spec1ﬁcat1ons T

_for the new state financial management system, or SMART. These specifications give state -
-~ agencies, like KDOT, the information we need to interface our systems the F1nanc1a1_ S
- ,Management System (FMS/SMART) '

KDOT has performed a Needs Assessment Study of our ﬁnanc1a1 systems and determmed thatr -

* two (2) systems internal to KDOT will be replaced by FMS (SMART). They are the Voucher"t c
Entry System (VES) and the Integrated Financial Management System (IFIS) L

The Voucher Entry Sy_stem, or VES, processes KDOT purchase requests/orders, invoices and -
payments. - The Voucher Payment and Procurement System supports the processing of purchase .

- requests and purchase orders for the agency. Purchase, receipt, invoicing, voucher, and payment
~processes are tracked by the system. The system interfaces with the Statewide Accounting and

Reporting System (STARS) and is used to generate payments triggered by voucher requests.”
The information collected in this system is also distributed to the KDOT Cost Center Feedback -

: - (CCFB) system for d1str1but10n to other cost centers and is d1str1buted to the IFIS budgetary s e
,. system : oA : : e : ,

. The Integrated F1nanc1a1 Management System or IFIS is KDOT’s general ledger system that-{.'_'.___
. integrates budget and expenditures. This general ledger system reflects a modified accrual basis.. =~ =
- of accounting, recognizing revenues when they become available and expenditures when the - =~
. liability is incurred. Standard financial and budget reports are supported by the system. Budget = =
. data is reported to the system, and summanzed expend1ture mformatlon by account is avallable' G
on—hne : . . . S

- -As the State Department of Admmlstratlon proceeds Wlth 1ts FMS (SMART) replacement'

project, KDOT will also need to integrate several of it’s remaining systems with SMART. These. -

. systems include CPMS and it’s. replacement WinCPMS, CMS C1ty Connectmg Lmks Crew_ :

Card and CCFB to name a few

- ‘An analy51s of the KDOT systems»resulted.in a recommendation of a staggered approach to
- replacing KDOT's mainframe applications. The staggered approach utilizes a short term and long
“term strategy. It is intended to prevent significant disruption to KDOT business processes in the -

short term, add value to KDOT's system architecture, and limit the time and effort required by -

. 'KDOT for the current State of Kansas FMS (SMART) project. The long term strategy will =~
‘involve replacing additional KDOT applications with functionality included in FMS (SMART). = "
' The replacement of these applications is optional. The work that can begin immediately- will © B

o mclude gettmg contracts estabhshed to beg1n the ana1y51s of the apphcat1ons that w111 need to, be S




interfaced based on information we know at this time. KDOT will be moving from a batch
- processing environment to. a real time environment with several apphcat1ons ‘This will be a .
: »s1gn1ﬁcant issue with these apphcatlons w1th regard to des1gn and alteratlons of OUI processes.
| - The total prOJ ect cost at this t1me is estlmated to be $7 79, 707 w1th the followmg breakdown

?-' $425,000 Contract Programmlng (FY 09-10)
$354 707 Intemal labor cost (FY 09-11) '

The prOJected close-out date for the F1nanc1a1 Management System Integratlon PI‘O_]eCt 1s_.-"' ‘.

‘December 201 1

Thank you for your trme I w111 gladly stand for questlons




Briefing to the Joint Committee on Information Technology
Regional Education and Workforce Access Remote Delivery Project
Kansas Department of Commerce |
D. Keith Meyers, Director of Training Services
April 29, 2009

Mr. Chairman, members of the committee, thank you for this opportunity to brief you on
- the progress to date on the Department of Commerce’s Regional Education and
‘Workforce Access Remote Delivery (REWARD) project. Since I presented to you on
December 8, 2008, the department’s detailed project plan was approved by the Executive
Branch CITO on January 30, 2009 and implementation commenced.

As a refresher, this project involves deploying high-definition videoconferencing units
and leveraging the current/planned availability of such units at libraries and
community/technical colleges throughout the state. This will allow Commerce and the
public workforce system (under the Workforce Investment Act) and Kansas
postsecondary educational partners to more effectively meet the needs of their current
customers and extend the geographic reach of employment services and training
opportunities, particularly to rural areas of the state. Services will be provided at a lower
cost than establishing additional bricks and mortar Workforce Centers or traveling to
provide outreach services. This technology-based method of providing employment and
training services will also save time and money for job seekers, employers, and program
participants.

With a broader deployment of the technology, the principal utilization of the equipment
will be to provide employment and training services as follows:

o Provide job search resume assistance for job seekers;

o - Present interviewing, job search, and resume writing workshops for
groups and/or individuals;

o Facilitate job candidate interviews for employers;

o Provide distance learning opportunities for dislocated workers and other
job seekers; .

o Conduct outreach and intake interviews with potential program
participants;

o Perform progress updates with program enrollees; and

o Provide prioritized and personalized services for military veterans and
their spouses.

Availability of this videoconferencing equipment in the field will also provide the

opportunity for agency and partner staff to participate in meetings with peers and
advisory boards in other locations thereby reducing travel costs.
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In conjunction with our work breakdown structure, the department completed the
installation and connection of site #1 at Hutchinson Community College on March 18,
2009 which was ahead of schedule and on budget. As a result of notification from the
Executive Branch CITO in March that the project was on hold until additional review by
the JCIT, the project was placed on hold.

The fiscal resources for the REWARD project are provided completely through federal
funding streams including Wagner-Peyser Act (labor exchange employment services)
funds, Workforce Investment Act funds, and a U.S. Department of Labor Dislocated
Worker Grant. These federal funds will provide for the establishment of nine high-
. definition videoconferencing units in the three local areas covered by the Dislocated
Worker Grant and for the required connectivity. The videoconferencing equipment for
this project will be procured from an existing state contract.

The Department of Commerce and its partners are eager to move forward with this
project for the benefit of Kansas job seekers and employers.
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And

Host Access Transmission Services (HATS)

Joint Committee on Information Technology
April 29, 2009

Chairman McLeland and members of the Committee, | am Don Jordan, Secretary of SRS. Thank you
for the opportunity to appear before you today to present our Protection Reporting Center (PRC) and
Host Access Transformation Services (HATS) projects.

Protection Reporting Center (PRC)

The Statewide PRC project involves the acquisition and implementation, through a Request for
Proposal (RFP), of an application that can meet the current and future needs of our Protection Report
Center. The project will acquire and implement a software solution for the intake, tracking, and
management reporting of abuse/neglect referral data for the protection of children and adults across
the State of Kansas. This project will standardize and improve the business processes for quality and
consistency of services across the State and implement a system to support and enable these new
processes. This project will improve the ability to consistently apply program policy and procedure
through the implementation of a software solution for Children and Family Services and Adult
Protective Services program areas statewide.

SRS currently has seven Protection Reporting Centers located across the State of Kansas to report
suspected adult and child abuse/neglect. These centers are currently functioning with a very limited
toolset and inconsistent business processes. Most of the reports come into our PRC centers by
phone through mandated Reporters, such as hospitals or schools and information is recorded in
multiple fashions and stored in various locations. The information for child abuse/neglect cases must
be manually entered again into another system, leaving room for errors and unnecessary duplication
of work.

The new application will provide an automated, uniform and consistent manner of processing all
reported cases of suspected child or adult abuse/neglect processed by SRS. The new system will be
required to implement an interface with the current SRS FACTS system which serves as a tracking
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and repository used for reporting to the U.S. Department of Health and Human Services for
suspected child abuse/neglect cases. The implementation of the interface should lead to less data
entry errors and more efficiency than the current manual data entry process.

We received CITO Approval for our High Level Plan on October 11, 2007.

We worked with the Division of Purchases and awarded a contract to Harmony Software on
December 23, 2008.

The contract with Harmony is $738,908 with an estimated completion date of February 11, 2010.

The following table shows the specific amount and year the funds for the PRC project were
encumbered and estimated amount of staff time allocated to the project.

Fiscal Year | Total Amount | State General Funds | Salary and Wages | Encumbered Funds

FYO07 $ 20,734 $ 20,734 $ 20,734 $ 359,175
FYO08 $ 30,270 $ 30,270 $ 30,270 $ 255,300
FY09 $ 468,334 $ 468,334 $ 113,809 $ 174,433
FY10 $ 544,946 $ 544,946 $ 110,563 $ 0
Grand Total | $ 1,064,284 $ 1,064,284 $ 275,376 $ 788,908

Host Access Transformation Services (HATS)

The Host Access Transformation Services (HATS) infrastructure project will provide for the purchase,
installation, and services (design and mentoring) of the HATS software. This software solution
provides our development staff with an easy to use tool that will allow them to transform and extend
our current major legacy systems using 3270 terminal emulation applications to the Web including
portals and mobile devices. The implementation of this project will establish the environment that will
enable the reuse of existing application functionality by other current applications or newly developed
applications in less time than traditional development methods. This environment will also support the
ability to transform our legacy applications directly to the web, while enhancing the usability through
web service components such as drop down lists, calendars, etc. These development tools
established in this project should provide our development staff with more efficient methods for
supporting and extending the functionality of our legacy systems to support the large backlog of
requests for the business users within SRS with many of these requests being either Federal or State
mandates.
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Implementing this infrastructure software project will enable SRS to better position itself to move
forward with supporting several of its legacy systems and implementing more tactical initiatives to
increase customer service and provide a more efficient workforce. This project is necessary because
the requested funding to implement the strategic Human Service Management (HSM) project that
would replace the major legacy applications within SRS has not been secured and funding will
probably not be available for a few years. Since funding will not be available to replace these legacy
systems for the foreseeable future, this project will meant to improve the productivity of development
staff to support these legacy systems and provide the necessary changes to support new initiatives in
the future to increase customer service and provide a more efficient workforce.

We received CITO Approval for our High Level Plan on December 29, 2008.

The actual HATS software was acquired on December 30, 2008 through the Software House
International (SHI) State contract at a cost of $230,100. The remaining project funds will be used for
implementation services.

The following table shows the specific amount and year the funds for the HATS project and estimated
amount of staff time allocated to the project.

Fiscal Year Total Amount | State General Funds | Salary and Wages | Encumbered Funds
FY09 $ 343477 $ 192,553 $ 61,577 $ 321,900
FY10 $ 58,671 $ 32,891 $ 18,671 $ 0
Total Amount | $ 402,148 $ 225,444 $ 80,248 $ 321,900

As you can see from the presentation, the funding for these two projects are very important to us so
that we can continue to provide more efficient ways for our staff to perform their job duties and
provide the necessary support for our legacy systems until we have the opportunity to replace them
with more modern systems in the future. ‘

| would be glad answer any questions the Committee may have at this time.
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KBI Testimony before the Joint Committee on Information Technology
KCJIS (KBI) Central Message Switch project status
4/29/2009

Presenter: Steve Montgomery, CIO, Kansas Bureau of Investigation

The KBI, on behalf of the Kansas Criminal Justice Information System (KCJIS), maintains and
supports the state’s central message switch (CMS) and other core KCIJIS hardware, software and
interfaces. KCJIS provides Kansas criminal justice agencies with a 24x7x365 access to
sensitive, criminal justice related data and provides a secure, instantaneous resource with which
to communicate with one another. This access is used for the protection of our nation by
providing the means for distributing immediate homeland security notifications to law
enforcement, and for providing criminal justice agencies with time-sensitive, critical information
maintained in national, state, and local databases, such as: the FBI’s National Crime Information
Center (NCIC) and wanted persons, suspected terrorists, stolen property, registered sex
offenders, Interstate Identification Index (III) and other state’s criminal history, driver’s license
and vehicle registration files.

One of the critical components of the KCJIS is the CMS, a very complex communication
platform that manages the information exchanges between KCJIS users and the various
repositories they access. Since the original CMS vendor’s bankruptcy in 1998 the KBI has
contracted with an independent vendor for critical support and maintenance of the CMS.
Consequently the CMS is in critical need of updating/replacement and is perpetually at risk of
losing support.

The KCJIS governance committee has for several years identified replacement ofthe CMS as a
priority element of the KCJIS strategic plan. Early in state fiscal year 2009 the KBI was able to
set aside monies from a fee fund to initiate the procurement of a new CMS. The project was
presented to the JCIT on November 20, 2008 and the high level project plan received CITO
approval in February of 2009.

Since February the CMS project has been of uncertain status due to budgetary issues, primarily
pertaining to dedicated telecommunication circuits upon which KCJIS relies. The KBI, on
behalf of KCJIS and the state, is the designated fiscal agent for provisioning of a single,
dedicated telecommunication circuit to each county. The circuits are managed and monitored by
the state to ensure that public safety communications can be reliably maintained even in a state
of emergency.

Starting in FY2010 the annual cost of the KCJIS telecommunication circuits will increase due to
technology changes that are occurring throughout the telecommunications industry. The KBI
was unsuccessful in receiving a FY2010 budget enhancement to cover the increased cost.
Having no other alternative it was decided to suspend the CMS project, redirecting the funds
instead to cover the cost for the KCJIS circuits for 1 year. This plan was presented to and
approved by the House Appropriations Committee in February of 2009. Recognizing the
solution as temporary in nature it was recognized that both the circuits and the CMS will
necessarily be revisited as part of the FY2011 budget process.
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It is therefore critically important that the $605,200 of funding estimated for the CMS project
remain in the KBI budget FY2010. Removing it would have several consequences that extend
well beyond replacement of the CMS:

1. Both projects, the CMS project and the telecommunication circuit upgrades, would
have to be canceled.

2. State support for the telecommunication circuits that provide the primary connection
for law enforcement to KCJIS will cease, placing the financial burden on local law
enforcement and potentially sacrificing secure and reliable communications for public
safety. }

3. Removing the full CMS project budget, $605,200, removes funding from the KBI

‘budget that will not available.
a. Included in the $605,200 estimate are internal costs for employee salaries that
will still be incurred if the CMS project is discontinued.
b. Included in the $605,200 funding need are maintenance contract savings that
will not be realized unless the CMS project is accomplished.
c. The $605,200 project budget is not restricted to a single year (FY2010) but
rather spread out over a 3 year period.

At a minimum the KCJIS community requires the $605,200 remain in the KBI FY10 budget in
order that the KCIJIS circuit upgrades may occur, so that existing critical staff may be retained,
and so essential KCJIS maintenance contracts may be funded.

Ideally, the KBI would be allowed to retain the $605,200 and use it for the CMS project as
originally planned, and also be provided a budget enhancement of $416,853 to fund the required
KCIJIS circuit upgrades.
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Recap: What is the UIM project and
its goals?

e
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Scope - All of Ul operations, systems and
processes

Improves customer service by making our
operations simpler and more efficient
- More accurate and timely services

- Recent changes (i.e. extended benefits program) have
been costly, time consuming and inefficient for customers

Ensures we meet customer needs with the most
cost effective and efficient methods; current
system is obsolete

Modernizes both business processes and
technology
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Progress since October, 2008

« Completed the Design Phase and now

embarking on the Build Phase

- December, 2008: Project was put on hold to deal
with the impacts of the economic recession and the
increasing number of Ul benefits claims; Ultimately
vendor and KDOL mutually agreed to end
relationship

« Changed our approach to more iterative
method of rolling out projects, allowing for

more manageable build and test phases

- Many specific accomplishments as part of this new
approach
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Strategic approach: Accomplishments
in line with vision and goal of UIM

* Online address changes
* Online account recovery
« Dedicated Contact Center queues

« Streamlining of Interactive Voice Recognition
(IVR) verbiage to shorten wait times

 Faxserver
* Unemployment benefits debit card

* |In Progress
- Automatic registration of Ul claimants with Commerce
- Electronic employer registration
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New approach to project

« Moving away from a grand “flip the switch”
implementation of the entire new system

» |terative and strategic approach will reconstruct
the end goal into smaller pieces (iterations) with
deployed technology and supporting
organizational change

» This will be accomplished with smaller vendor
engagements and temporary augmentation of IT
staff

« This approach will bring more immediate benefits
and enable us to be more agile
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Next steps

« Economic crisis has caused us to reorder timing
of certain developments

« Working with KITO office regarding startup of the
UIM Build and Deploy projects
« Upcoming “Build” projects:
- Deployment of Genesys into the Contact Center

- Deployment of FileNet for quarterly wage reporting
process

- Performing the upgrade of our Siebel environment to the
Siebel public sector solution

« Budget remains adequate to complete the project
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Conclusion

* We want to be sure the project is done
right
 UIM addresses a real need for our

customers and our agency—replacing an
obsolete, inflexible system

* We will save operating costs for agency
and employers |

* |t will improve customer service




